
1

Shelly Cashman: Microsoft Excel 2021

Module 2: Formulas, Functions, and Formatting
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Objectives (1 of 2)

•Use Flash Fill

• Enter formulas using the keyboard

• Enter formulas using Point mode

•Apply the MAX, MIN, and AVERAGE functions

• Verify a formula using Range Finder

•Apply a theme to a workbook

•Apply a date format to a cell or range
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Objectives (2 of 2) 

•Add conditional formatting to cells

• Change column width and row height

• Check the spelling on a worksheet

• Change margins and headers in Page Layout view

• Preview and print versions and sections of a worksheet
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Project: Worksheet with Formulas and 
Functions

-4-Table 1: A Salary Report Worksheet



Entering the Titles and Numbers into the 
Worksheet (1 of 2)

•To Enter the Worksheet Title and Subtitle

• Run Excel and create a blank workbook

• Select cell A1 and type the desired worksheet title (Klapore 
Engineering), then press the DOWN ARROW key to enter it

• Select cell A2 and type the worksheet subtitle (Salary Report) 
then press the DOWN ARROW key to enter it

•To Enter the Column Titles

• Select cell A3 and type the desired text, then press the RIGHT 
ARROW key to enter the column heading

• Continue until all the columns you desire have headings

(Employee, Email Address, Dependents, Hours ALT+ENTER 
Worked, Hourly ALT+ENTER Pay Rates, Gross Pay, Federal Tax, 
State Tax, Tax %, Net Pay, Hire Date) -5-



Entering the Titles and Numbers into the 
Worksheet (2 of 2)

•To Enter the Salary Data

• Select cell A4, type desired name (Altore, Benie), and then 
press the RIGHT ARROW key two times to enter the 
employee name and make cell C4 the active cell

• Type a number (3) in cell C4 and then press the RIGHT 
ARROW key

• Type a number of hours worked (74.50) in cell D4 and then 
press the RIGHT ARROW key

• Type an hourly rate (35.25) in cell E4

• Click cell K4 and type a date (9/5/10) 

•Use the data in Table 2-1 to enter salary data for the 
remaining employees into the worksheet
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Table 2-1

-7-



Flash Fill (1 of 2)

•To Use Flash Fill – automatically fills or formats data in 
remaining cells based on patterns of previous cells

• Click a cell (B4)

• Type desired text (baltore@example.com) and then press 
the DOWN ARROW to select the next cell (B5) 

• Type desired text (lfox@example.com) following the same 
pattern (….@example.com) and then click the Enter button

• Select the range (B4:B12)

• Click Data on the ribbon to select the Data tab

• Click Flash Fill (Data tab | Data Tools group) to enter 
similarly formatted text (email addresses) in cells B6:B12

• If necessary, delete entries in cells B1:B2
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Flash Fill (2 of 2)

• To Enter the Row Titles

• Select a cell in the A column (A13:A16)

• Type desired text and then press the DOWN ARROW key to 
enter a row header (Totals, Highest, Lowest, Average)

• Continue until all Rows have a header

• To Change the Sheet Tab Name and Color

• Double-click the Sheet1 tab and enter the desired text (Salary 
Report) as the sheet tab name and then press the ENTER key

• Right-click the sheet tab to display the shortcut menu

• Point to Tab Color on the shortcut menu to display the Tab Color 
gallery. Click desired color { Blue, Accent 1 (col 5, row 1) }

• Save the workbook
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Entering Formulas (1 of 5)

•To Enter a Formula Using the Keyboard

•With the cell to contain the formula selected (F4), type the 
formula (=d4*e4) in the cell to display the formula in the 
formula bar and in the current cell and to display colored 
borders around the cells referenced in the formula 

• Press TAB to complete the arithmetic operation indicated 
by the formula, to display the result in the worksheet, and 
to select the cell to the right
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Entering Formulas (2 of 5)

-11-



Entering Formulas (3 of 5)

•Arithmetic Operations and Their Order of Operations

• From left to right

-First negation (−)

-Then percentages (%)

-Then all exponentiations (^)

-Then all multiplications (*) and divisions (/)

-Finally all additions (+) and subtractions (−)
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Entering Formulas (4 of 5)

• To Enter Formulas Using Point Mode

• With the cell that is to contain the formula selected (G4), begin 
typing the formula and then click another cell to add a cell 
reference in the formula { 0.26*(F4-C4*22.16) }

• Finish typing the rest of the formula { H4 = 0.055*F4, 

 I4 = (G4 + H4) / F4,     J4 = F4 – (G4+H4) }

• Click the Enter box in the formula bar when you have finished 
entering the formula 
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Entering Formulas (5 of 5)

•To Copy Formulas Using the Fill Handle

• Select the source range (F4:J4), point to the fill handle, 
drag the fill handle down to desired location, and continue 
to hold the mouse button to select the destination range 
(F5:J12)

• Release the mouse to copy the formulas to the destination 
range

-14-



Option Buttons (1 of 3)

Excel displays option buttons to indicate that you can complete an 
operation using automatic features. (p14-Auto Fill Options button)

Table 2-4 Option Buttons in Excel

Name Menu Function

Auto Fill Options Provides options for how to fill cells following a fill 
operation, such as dragging the fill handle

AutoCorrect Options Undoes an automatic correction, stops future 
automatic corrections of this type, or causes Excel to 
display the AutoCorrect Options dialog box

Insert Options Lists formatting options following an insertion of 
cells, rows, or columns

Paste Options Specifies how moved or pasted items should appear 
(for example, with original formatting, without 
formatting, or with different formatting)

Trace Error Lists error-checking options following the 
assignment of an invalid formula to a cell
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Option Buttons (2 of 3)

•To Determine Totals Using the AutoSum Button

•Display the Home tab

• Select the desired cell to contain the sum (D13), click the 
AutoSum button (Editing group) to sum the contents of the 
range (D4:D12) and click ENTER to display the total in the 
selected cell

• Select the range to contain the sums (F13:H13). Click the 
AutoSum button to display totals in the selected range

• Select the cell to contain the sum (J13), click the AutoSum 
button to sum the contents of the range and click ENTER
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Option Buttons (3 of 3)

•To Determine the Total Tax Percentage

• Select the cell to be copied (I12) and then drag the fill 
handle down through the desired cell (I13) to copy the 
formula
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Using the AVERAGE, MAX, MIN, and other 
Statistical Functions (1 of 6)

•To Determine the Highest Number in a Range of 
Numbers Using the Insert Function Dialog box

• Select the cell to contain the maximum number (C14)

• Click the Insert Function button in the formula bar to 
display the Insert Function dialog box

• If necessary, scroll to and then click MAX in the Select a 
function list 

• Click the OK button to display the Function Arguments 
dialog box and type the cell range (C4:C12) in the Number1 
box to enter the first argument of the function 

• Click the OK button to display the highest value in the 
chosen range in the selected cell
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Using the AVERAGE, MAX, and MIN 
Functions (2 of 6)

•To Determine the Lowest Number in a Range of 
Numbers Using the Sum Menu

• Select cell (C15) that is to contain the minimum value and 
then click the AutoSum arrow in the HOME tab

• Click Min to display the MIN function in the formula bar 
and in the active cell 

•Drag through the range (C4:C12) of values of which you 
want to determine the lowest number 

• Click the Enter box to determine the lowest value in the 
range and display the result in the formula bar and in the 
selected cell

-19-



Using the AVERAGE, MAX, and MIN 
Functions (3 of 6)
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Display of selected range appearing in the formula bar and active cell



Using the AVERAGE, MAX, and MIN 
Functions (4 of 6)

•To Determine the Average of a Range of Numbers Using 
the Keyboard

• Select the cell (C16) that will contain the average 

• Type =av in the cell to display the Formula AutoComplete list 
Press the DOWN ARROW key to highlight the required 
formula (AVERAGE)

•Double-click AVERAGE in the Formula AutoComplete list to 
select the function

• Select the range (C4:C12) to be averaged to insert the range 
as the argument to the function

• Click the Enter box to compute the average of the numbers 
in the selected range and display the result in the selected 
cell
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Using the AVERAGE, MAX, and MIN 
Functions (5 of 6)
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Display of Formula AutoComplete list and AVERAGE function name



Using the AVERAGE, MAX, and MIN 
Functions (6 of 6)

•To Copy a Range of Cells across Columns to an Adjacent 
Range Using the Fill Handle

• Select the source range (C14:C16) from which to copy the 
functions

•Drag the fill handle in the lower-right corner of the 
selected range through the desired selection cell to copy 
the functions to the selected range (through J16)

• Select cell I16 and  delete the average of Tax % which is 
mathematically invalid
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Verifying Formulas using Range Finder

•To Verify a Formula Using Range Finder

•Double-click a cell (I4) to activate Range Finder

• Press the ESC key to quit Range Finder and then click 
anywhere in the worksheet to deselect the current cell
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Formatting the Worksheet (1 of 15)
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In Module 1 we used cell 
styles to format worksheet.
In Module 2 we will use 
themes to format the 
worksheet.



Formatting the Worksheet (2 of 15)

•To Change the Workbook Theme

• Click the Themes button on the Page Layout tab to display 
the Themes gallery

• Click the desired theme (Gallery, #3) in the Themes gallery 
to change the workbook theme
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Formatting the Worksheet (3 of 15)

• To Format the Worksheet Titles

• Display the Home tab. Select the range (A1:K1) to be merged, 
click MERGE & CENTER. Repeat this for (A2:K2) 

• Select the range (A1:A2) to contain the Title cell style, click Cell 
Styles button to display the Cell Styles gallery and choose a 
style (Title)

• Select A2 and click “Decrease Font Size” button (Font group)
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Formatting the Worksheet (4 of 15)

•To Change the Background Color and Apply a Box 
Border to the Worksheet Title and Subtitle

• Select the range (A1:A2) to color and then click the Fill 
Color arrow (HOME tab | Font group ) to display the Fill 
Color gallery

• Click a color (Indigo, Accent 5, Lighter 80%) (col 9, row 2) to 
select it and change the background color of the cells

• Click the Borders arrow (HOME tab | Font group) to display 
the Borders gallery

• Click a border (Outside Borders) in the Borders gallery to 
select it and display a border around the selected range
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Formatting the Worksheet (5 of 15)

•To Apply a Cell Style to the Column Headings and 
Format the Total Rows

• Select the range (A3:K3) to be formatted

•Use the Cell Styles gallery (Home tab | Styles group) to 
apply the cell style (Heading 3)

• Click the Center button (Home tab | Alignment group) to 
center the column headings

•Apply the Total cell style to the range (A13:K13)

• Bold the range (A14:A16)

-29-



Formatting the Worksheet (6 of 15)

• To Format Dates and Center Data in Cells

• Select the range (K4:K12) to contain the new date format

• On the HOME tab in the Number group, click the Dialog Box 
Launcher (lower right) to display the Format Cells dialog box

• If necessary, click the NUMBER tab and click Date in the 
Category list, and then click a date type (3/14/12) to choose the 
format for the selected range

• Click the OK button to format the dates in the current column 
using the selected date format style

• Select the range (C4:C16) to be centered and then click the 
Center button (HOME tab | Alignment group) to center the data 
in the selected range
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Formatting the Worksheet (7 of 15)

•To Apply an Accounting Number Format and Comma 
Style Format Using the Ribbon

• Select the range (E4:H4) to contain the accounting number 
format 

•While holding down the CTRL key, select the nonadjacent 
ranges and cells (J4, F13:H13, J13)

• Click the “Accounting Number Format” button (HOME tab 
| Number group) to apply the accounting number format

• Select nonadjacent ranges (E5:H12, J5:J12, D4:D16)

• Click the “Comma Style” button (HOME tab | Number 
group) to assign the Comma style format
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Formatting the Worksheet (8 of 15)

•To Apply a Currency Style Format with a Floating Dollar 
Sign Using the Format Cells Dialog Box

• Select the ranges (E14:H16 + J14:J16) to format and then on 
[HOME tab | Number group], click the Dialog Box Launcher 
(lower right) to display the Format Cells dialog box

• If necessary, click the Number tab

• Click Currency in the Category list to select the necessary 
number format category, Click $ in the Symbol list and then 
tap or click a style in the Negative numbers list to select the 
desired currency format ($1,234.10)

• Click the OK button to assign the currency style format to the 
selected ranges
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Formatting the Worksheet (9 of 15)

•To Apply Percent Style Format and Using the Increase 
Decimal Button

• Select the range to format (I4:I15)

• Click the Percent Style button (HOME tab | Number group) 
to display the numbers in the selected range as a rounded 
whole percent

• Click the Increase Decimal button (HOME tab | Number 
group) two times to display the numbers in the selected 
range with two decimal places
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Formatting the Worksheet (10 of 15)

•To Apply Conditional Formatting

• Select the range (D4:D12) to which you wish to apply 
conditional formatting (a value > 70 will appear with a 
purple background and a white font)

• Click the Conditional Formatting button (HOME tab | 
Styles group) to display the Conditional Formatting menu

• Click New Rule in the Conditional Formatting menu to 
display the New Formatting Rule dialog box

• Click the desired rule type (Format only cells that contain) 
in the Select a Rule Type area

• Select and type the desired values in the Edit the Rule 
Description area (2nd box = “greater than”, 3rd box = “70”)
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Formatting the Worksheet (11 of 15)

•To Apply Conditional Formatting (continued)

• Click the Format button (New Formatting Rule dialog box) 
to display the Format Cells dialog box

• If necessary, click the font tab (Format Cells dialog box)

• Click the Color arrow to display the Color gallery and then 
click White Background 1 (col #1, row #1) to select the font 
color

• Click the Fill tab (Format Cells dialog box) and click the 
purple color (col #8, row #1) to select the background color

• Click OK (Format Cells dialog box)

• Click OK (New Formatting Rule dialog box)
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Formatting the Worksheet(12 of 15)

Table 2-5 Summary of Conditional Formatting Relational Operators

Relational Operator Formatting will be applied if…

Between cell value is between two numbers

not between cell value is not between two numbers

equal to cell value is equal to a number

not equal to cell value is not equal to a number

greater than cell value is greater than a number

less than cell value is less than a number

greater than or equal to cell value is greater than or equal to a number

less than or equal to cell value is less than or equal to a number
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Formatting the Worksheet (13 of 15)

•To Change Column Width (Best Fit or Desired Width) 

•Drag through column headings (A, B, C) to select the columns 

• Point to the boundary on the right side of column heading C 
to cause the pointer to become a split double arrow

•Double-click the right boundary of the column heading C to 
change the width of the selected columns to best fit

• To resize a column (H) by dragging, point to the boundary of 
the right side of the column heading (H). When the mouse 
pointer changes to a split double arrow, drag to the desired 
width (ScreenTip: 10.38 / 88 pixels), and then lift your finger 
or release the mouse button to change the column widths
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Formatting the Worksheet (14 of 15)

•To Change Column Width (Continued)

•Hold down CTRL and Click column D, E & I headings above 
row 1 to select these nonadjacent columns

• Point to the right side of the column I heading boundary 

•Drag until ScreenTip shows Width: 10.50 (89 pixels) and then 
release the mouse button

•Hold down CTRL and Click column headings (F, G, J & K) to 
select these nonadjacent columns

•Drag the boundary on the right side of the column G until the 
ScreenTip indicates Width: 11.13 (94 pixels)  

• Release the button to change the column widths
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Formatting the Worksheet (15 of 15)

•To Change the Row Height

• Point to the boundary below the row heading (3) to resize 
until the pointer becomes a split double arrow

•Drag the boundary to the desired row height (ScreenTip: 
39.00 / 52 pixels) and then release the mouse button

• Lift your finger or release the mouse button to change the 
row height

•Do the same for row heading (14) to change the row height 
to ScreenTip: 24.00 (32 pixels)
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Checking Spelling

•To Check Spelling on the Worksheet

• Click cell A1 so that the spell checker begins at the 
beginning of the worksheet

• Click the Spelling button (REVIEW tab | Proofing group) to 
run the spell checker and display the misspelled words in 
the Spelling dialog box

•Apply the desired action to each misspelled word

•When the spell checker is finished, click the Close button
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Printing the Worksheet (1 of 3)

• To Change the Worksheet’s Margins, Header, and Orientation in Page 
Layout View

• Click the Page Layout button on the status bar to view the worksheet in Page 
Layout view

• Click the Margins button (PAGE LAYOUT tab | Page Setup group) to display the 
Margins gallery

• Click the desired margin style (Narrow) to change the worksheet margins to 
the selected style

• Click above cell A1 in the center of the Header area

• Type the desired worksheet header (Madelyn Samuels + ENTER + Chief 
Financial Officer), and then deselect the header

• Click the “Orientation” button (PAGE LAYOUT tab | Page Setup group) to 
display the Orientation gallery

• Click the desired orientation (Landscape) to change the orientation

• Double click the borders of column headings F & J to best fit the columns
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Printing the Worksheet (2 of 3)

•To Print a Worksheet

• Click FILE on the ribbon to open Backstage view

• Click the Print to display the Print screen

• If necessary, click Printer Status button to display a list of 
available printer and click the desired printer

• Click the No Scaling button and then select “Fit Sheet on 
One Page”

• Click Print
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Printing the Worksheet (3 of 3)

•To Print a Section of the Worksheet

• Select the range to print (A3:F16)

• Click FILE on the ribbon to open Backstage view

• Click the Print to display the Print screen

• Click “Print Active Sheets” in the Settings area on the 
PRINT screen to display a list of printing options 

• Click Print Selection to print the selected range

• Click the Print button in the Print screen to print the 
selected range of the worksheet 

• Click the Normal button on the status bar to return to 
Normal view
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Displaying and Printing the Formulas Version 
of the Worksheet (1 of 2)

• To Display the Formulas in the Worksheet and Fit the 
Printout on One Page
• Press CTRL+ACCENT MARK (`) (upper-left) to display the 

worksheet with formulas

• Click the Page Setup Dialog Box Launcher (Page Layout tab | Page 
Setup group, lower-right) to display the Page Setup dialog box

• If necessary, click the Landscape Orientation in the Page sheet 

• If necessary, click Fit to in the Scaling area to select it

• Click the Print button to open the Print screen in Backstage view. 
Select the Print Selection button in the Settings area of the Print 
gallery and then click Print Active Sheets

• Click the Print button to print the worksheet

• After viewing and printing the formulas version, press 
CTRL+ACCENT MARK (`) to display the values version
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Displaying and Printing the Formulas Version 
of the Worksheet (2 of 2)

•To Change the Print Scaling Option Back to 100%

• Click the Page Setup Dialog Box Launcher on the PAGE 
LAYOUT tab to display the Page Setup dialog box

• Click the Adjust to option button in the Scaling area to 
select the Adjust to setting

• If necessary, type 100 in the Adjust to box to adjust the 
print scaling to 100%

• Click OK

•Display the Home tab

• Save the workbook, sign out and exit Excel
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